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В методические указания вошли две лабораторные работы, посвященные 

электрохимической обработке металлов. В работах кратко изложена теория ЭХО, а также 
описаны методики проведения расчётов в программах Ansys и Fluent. 

Методические указания предназначены для студентов, обучающихся по специальности 
160301 - «Авиационные двигатели и энергетические установки», изучающих курсы 
«Технология производства АД и ЭУ», «Технологические методы обеспечения надежности 
деталей ГТД» и «Информационные технологии». 

Методические указания разработаны на кафедре производства двигателей летательных 
аппаратов. 

 



СОВЕРШЕНСТВОВАНИЕ ТЕХНОЛОГИИ УДАЛЕНИЯ ЗАУСЕНЦЕВ С ТОНКОСТЕННЫХ 
ДЕТАЛЕЙ ГТД ЭЛЕКТРОХИМИЧЕСКИМ МЕТОДОМ 

 
Цель работы: при помощи моделей высокого уровня выбрать наилучшую схему обработки для 

снятия заусенцев и изучить закономерности распределения потенциалов в электрохимической ячейке и 
особенности анодного растворения поверхностей. 
 



ОБЩИЕ  СВЕДЕНИЯ 

Современные авиационные газотурбинные двигатели (ГТД) являются весьма сложными по 
конструкции и трудоёмкими в изготовлении. Поэтому при серийном производстве двигателей уделяется 
большое внимание вопросам снижения трудоёмкости и повышения качества изготовления деталей с 
целью увеличения надёжности их работы и ресурса ГТД. Для решения этих задач на 
авиадвигателестроительных заводах широко применяются высокопроизводительное оборудование и 
новые прогрессивные методы обработки для изготовления деталей. Научно-технический прогресс 
промышленности, в первую очередь, должен обеспечивать сокращение доли ручного труда и устранять 
вредные для здоровья человека производственные условия. Благодаря техническим решениям уже на 
современном этапе удалось значительно сократить, а в ряде случаев почти полностью ликвидировать 
такие работы. Однако, несмотря на это, еще сравнительно велика доля ручного труда в общей 
трудоёмкости изготовления двигателя, причём значительную часть её занимают слесарно-
полировальные работы, обеспечивающие надёжность и ресурс современных ГТД. 

Традиционное ручное выполнение слесарно-полировальных работ, как правило, не обеспечивает 
стабильное высокое качество отделки поверхности, не позволяет достигать высокого качества физико-
химического состояния поверхностного слоя, что существенно сказывается на надежности работы и 
ресурсе высоконагруженных деталей двигателя, требует многоступенчатого контроля. Слесарный 
способ выполнения указанных работ является физически тяжёлым и вредным для здоровья. Поэтому 
задача механизации выполнения слесарно-полировальных работ, в основном представленных 
удалением заусенцев, скруглением и полировкой кромок, представляется весьма важной и 
своевременной. 

Теория и практика показали, что для решения данной задачи в производстве наиболее эффективно 
применять электрохимический метод обработки, не требующий дорогостоящих специализированных 
установок и дорогостоящего и быстроизнашиваемого инструмента. Однако электрохимическая 
обработка еще недостаточно изучена, а это сдерживает не только область её применения, но и 
получение более высокого качества обработанных поверхностей деталей. Для проектирования 
оптимальных технологий ЭХО перспективным направлением является использование компьютерных 
моделей высокого уровня для выбора наиболее выгодных схем и режимов обработки. 
 



 

ТЕОРЕТИЧЕСКАЯ  ЧАСТЬ 

Особенности формообразования поверхности при ЭХО кромок обусловлены следующими 
основными факторами: увеличением напряженности электрического поля на острой кромке и 
заусенцев, что приводит к их преимущественному растворению; наличием в рабочем зазоре 
заусенца, имеющего неопределенную форму и размеры, а это затрудняет эвакуацию 
продуктов растворения, установку начального межэлектродного зазора, создает 
дополнительную опасность возникновения коротких замыканий; высокой неравномерностью 
снимаемого припуска (по биссектрисе угла скругляемой кромки припуск может составлять 
несколько миллиметров, а в точке сопряжения радиуса с плоскостью припуск близок нулю). 

С учетом рассмотренных особенностей процесса скругления кромок разработаны и 
находят применение различные схемы обработки. Для мелких неответственных деталей 
используется наиболее простая и производительная схема общего травления (детали 
загружаются в барабан с добавлением мраморной крошки и т.п.). Для сложных и 
ответственных деталей должно быть обеспечено локальное травление, поэтому применяются 
схемы с фиксированным расположением электродов относительно кромки. В зависимости от 
конструктивных особенностей деталей схемы могут иметь отличие по способу подачи 
электролита, по методам защиты от растравливания необрабатываемых поверхностей, по 
количеству одновременно обрабатываемых деталей и т.п. При обработке большими 
радиусами скругления на деталях из титанового сплава в схеме обработки должна быть 
предусмотрена подача электрода-инструмента. Все эти особенности реализуются при 
проектировании катодного устройства. 

Важнейшими требованиями к технологическому процессу ЭХО кромок деталей является 
получение заданной точности обработки и качества поверхностей. В этой связи важное 
значение имеет профилирование формообразующей поверхности и защита 
необрабатываемых поверхностей от растравливания. При снятии заусенцев, когда величина 
радиуса скругления кромки не регламентируется, а обрабатываемый материала не склонен к 
образованию питтингов, форма рабочего пояска электрода-инструмента определяется только 
конструктивными особенностями катодного устройства, и рабочие поверхности не надо 
специально профилировать. 

При обработке радиусов заданной величины на деталях из непассивирующихся 
материалов (не склонных к образованию питтингов) при перпендикулярном расположении 
скругляемой кромки и формообразующего буртика рабочий поясок выполняется в виде 
плоской поверхности шириной около 1 мм, расположенной перпендикулярно к скругляемой 
кромке. Величина радиуса скругления в этом случае зависит от времени обработки, 
определяемого по формуле: 
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где К - коэффициент, учитывающий ширину рабочего пояска (при ширине 1 мм величину К 
можно принять равной 1). 

Экспериментальными исследованиями установлено, что увеличение рабочей поверхности 
катода с 0,5 до 2,0 мм увеличивает съем с кромки и способствует росту радиуса скругления, 
но до некоторого предела. При определенных соотношениях размеров электрохимической 
 



 

ячейки (рабочей части катода, радиуса скругления и межэлектродного зазора) боковой съем 
может быть так велик, что при увеличении времени обработки рост радиуса скругления 
прекратится. 

При скруглении кромок на деталях из титановых сплавов должна быть обеспечена 
конечная величина межэлектродного зазора (МЭЗ) не более 1 мм (для получения высокого 
качества поверхностного слоя), а необрабатываемые поверхности должны быть защищены от 
растравливания. В этом случае формируется ступенька в месте сопряжения радиуса и 
необрабатываемых поверхностей, защищенных специальными покрытиями, или способом 
катодной защиты. Для уменьшения величины этой ступеньки рабочая поверхность катода 
может быть специально спрофилирована. На рис.1 приведены расчетные схемы 
профилирования катода-инструмента при параллельном и перпендикулярном его 
расположении. Профилирование производится графоаналитическим методом. Проводится 
приближенный расчет конечных МЭЗ для случая ЭХО при неподвижном 
электроде-инструменте. Основой расчета является определение времени скругления из 
условия снятия максимального припуска Zmax (съем по биссектрисе скругляемого угла) и 
нахождение зазоров в каждой точке скругляемого радиуса из условия рассчитано- го времени 
обработки, заданной величины съема при принятой форме МЭК, при этом принимаем линии 
тока по Lx (рис.1, а) и по линии 3-2 (рис.1, б). Исходя из рассмотренных условий и принятых 
расчетных схем величина начального МЭЗ в любой точке обрабатываемой поверхности 
может быть определена по формуле: 
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Для графического построения профиля электрода (рис. 1, а) необходимо определить угол 
β, который образован линиями, проведенными из центра O1, через расчетные точки на 
поверхности заготовки и профиля электрода-инструмента: 
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Отложив на чертеже величину этого угла для ряда расчетных точек в пределах 0<lx<0,6r, 

получим профиль электрода-инструмента. Непрофилированная часть поверхности катода 
изолируется. Профилированная поверхность выполняется симметричной относи-тельно 
биссектрисы угла. 

Для расчетной схемы (рис.1, б) форму МЭК принимают в соответствии с линией 3-2. 
Тогда вместо Lx находим длину отрезка hx и, откладывая значение hx на чертеже, для ряда 
расчетных точек в пределах 0<lx<0,6r получаем профиль электрода-инструмента. В этом 
случае профилирование проводится для половины электрода-инструмента, прилежащей к 
скругляемой поверхности. 
 

 



ПРАКТИЧЕСКАЯ  ЧАСТЬ 

Электрохимическое удаление заусенцев и скругление острых кромок деталей основано на 
явлении повышенной напряженности электрического поля вблизи острых кромок, т.е. 
поверхностей с малыми радиусами кривизны. Как следствие этого, локальная плотность тока 
на поверхности с малым радиусом кривизны при ЭХО на порядок и более выше, чем на 
прилегающей поверхности и съем металла происходит преимущественно с острой кромки 
заготовки, практически не затрагивая остальные её поверхности. Зона электрохимического 
воздействия ограничивается участком в 3÷5 мм от обрабатываемой кромки. Для 
формирования требуемого чертежом детали радиуса скругления кромки предлагаются 
различные формы катодов-инструментов. Однако эти данные получены для массивных 
толстостенных деталей, толщина материала которых в зоне, прилегающей к участку 
поверхности, обрабатываемому ЭХО, много больше межэлетродного зазора и радиуса 
скругления кромки. 

Для тонкостенных деталей ГТД толщина стенки деталей и радиус скругления кромки 
являются величинами одного порядка. Сама скругляемая кромка может рассматриваться как 
поверхность с малым радиусом кривизны, и не ясно, будут ли острые углы на этой острой 
кромке играть роль дополнительных источников повышенной напряжённости электрического 
поля. С другой стороны, известно, что при ЭХО невозможно получить поверхности с 
острыми кромками. 

Для тонкостенных деталей нет ясности, какая форма катода-инструмента может 
обеспечить получение скругления острой кромки заданной величины и оказывает ли форма 
катода какое-либо влияние на электрохимическое скругление острой кромки неподвижным 
катодом-инструментом. 

Конфигурация электрохимической ячейки при электрохимическом удалении заусенцев и 
скруглении острых кромок существенно отличается от обычно рассматриваемого при ЭХО 
плоско-параллельного зазора между анодом-заготовкой и катодом-инструментом. Если в 
направлении вдоль образующей заготовки катод-инструмент копирует контур заготовки, то в 
направлении перпендикулярном образующей заготовки, поверхность заготовки и 
неподвижного катода-инструмента должны образовать такую электрохимическую ячейку, 
конфигурация электрического поля в которой обеспечивала бы удаление имеющегося 
заусенца; формирование на месте острой кромки скруглённой поверхности заданного 
радиуса; поддержание плотности тока, достаточной для формирования заданной 
микрогеометрии поверхности (полированной поверхности). 

Рассматривая конфигурацию кромки заготовки тонкостенной детали после штамповки на 
ней, можно выделить ряд характерных элементов (см. рис.2): АВ и ЕЖ - участки плоской 
поверхности исходного материала, БВ - скруглённый участок (образующийся на входе 
инструмента при операциях холодной штамповки), ВГ - плоский торцевой участок с 
поверхностным дефектным слоем, ГДЕ - заусенец. 

В результате электрохимической обработки требуется получить поверхность АВ1О2Г1Ж, 
образованную вписанными в контур заготовки радиусами R1 и R2, которые в пределе 
стремятся к Н/2 - половине толщины исходной листовой заготовки. 

Как видно из рис.2, величина припуска, подлежащего удалению с правой и левой сторон 
заготовки, различна. Это создает трудность в определении конфигурации катода-



инструмента, который должен обеспечить симметричный контур обработанной детали. 
Принципиально возможны две схемы расположения катода-инструмента (см. рис.3): 
а) катод-инструмент перпендикулярен заусенцу; 
б) катод-инструмент параллелен заусенцу. 

Схема "а" обеспечивает наименьшее изменение размеров исходной заготовки за счёт 
электрохимической обработки торца, однако не даёт возможности получить симметричное 
скругление по сторонам обрабатываемой заготовки. К тому же не прогнозируемая высота 
заусенца не исключает возможность возникновения короткого замыкания между заготовкой 
и катодом, который обычно  
располагается на фиксированном расстоянии от поверхности заготовки. Поэтому 
предпочтительнее схема «б», принципиально исключающая возможность коротких 
замыканий. Эта схема должна обеспечивать получение более симметричного скругления 
кромок заготовки, однако её использование может привести к значительному изменению 
размеров детали за счёт интенсивного торцевого электрохимического съема. В дальнейшем в 
данной работе будем использовать схему «б». 

Конфигурация катода должна при прочих равных условиях обеспечить максимальную 
плотность тока на острых кромках скругляемой поверхности в начале обработки и в 
конечный момент обработки на участке В1О2Г1, а также минимальную плотность тока на 
поверхности АВ1 и ГЖ1 (см. рис.2)  для того, чтобы устранить возможность утонения 
основного материала заготовки. 

Для выявления качественной зависимости распределения плотности тока по поверхности 
заготовки от конфигурации катода используем метод моделирования в программе ANSYS. 
Чтобы обеспечить соответствие геометрического подобия натуры и модели электрического 
поля, была взята плоскость Р, изображённая на рис. 4, секущая рабочую зону 
электрохимического скругления острых кромок перпендикулярно образующей.  

 

Рис. 4. Принципиальная схема скругления острых кромок 
на тонкостенных деталях электрохимическим методом 

 
В этой плоскости выделена область, ограниченная точками АВО1О, заключающая в себе 



межэлектродный промежуток и прилегающую к нему зону. Этот приём позволил перейти от 
трёхмерного электрического поля к двухмерному и дал возможность моделировать его. 
Размеры модели электрического поля выбирались из условий обеспечения 
беспрепятственного измерения потенциалов. Так, если межэлектродный промежуток в натуре 
равен 0,5 мм, а толщина обрабатываемой заготовки 1,0 мм, то для удобства на модели они 
равны соответственно 50 и 100 мм, т.е. вся область измерения была изготовлена в масштабе 
100:1. Вследствие симметричности зоны обработки моделировалась только правая половина 
электрохимической ячейки. 

Компьютерное моделирование электрических полей с использованием программного 
комплекса ANSYS существенно упрощает анализ и дает более наглядную картину для 
определения основных закономерностей формирования потенциальных электрических полей 
и изучения их конфигурации. В качестве примера смоделируем электрическое поле для 
схемы, которая показана на рис.5 (без учета заусенца). 

Здесь линии 8-9, 9-2 - поверхности анода, 5-6 - поверхность катода, область, ограниченная 
точками (2,3,4,5,6,7,8,9) - электропроводящая среда (в реальности ЭХО-электролит), в 
настоящей модели область, подвергаемая разбиению на конечные элементы. По линиям 8-9, 
9-2, 5-6 - моделируемая область имеет приложенные нагрузки в виде электрического 
напряжения. 

По линиям 2-3, 3-4, 4-5, 6-7, 7-8 моделируемая область граничит с диэлектриком, 
следовательно здесь граничный потенциал не задан, просто область заканчивается. Тоесть 

ток в направлении границы равен нулю, или 
0=

dx
dϕ

. 
Граничный потенциал вдоль линий анода и катода будет равен: 
φ2-9=φ9-8=+20 В - анод (заготовка), 
φ5-6=0 В - катод (электрод инструмент). 

 



ПОРЯДОК ВЫПОЛНЕНИЯ ЛАБОРАТОРНОЙ РАБОТЫ 

Запускаем ANSYS: 
Пуск→Программы→ANSYS 9.0→ANSYS Product Launcher; 
Выбираем среду моделирования ANSYS, вид расчета ANSYS Multiphisics. 
Определяем местоположение рабочей папки (например, D:/USER/EHO) и название 

проекта zausenec1 (рис. 6). 

 
Рис. 6. Диалоговое окно для выбора рабочей папки и названия проекта 

Запускаем ANSYS нажатием кнопки RUN. 
 
Работаем в древовидном списке Д сверху вниз: 
Подготовительный шаг. Убираем из списка ненужные пункты. Выбираем 

электромагнитный расчет (рис. 7): 
Preferences→Electric→ОК 

 
Рис. 7. Диалоговое окно для выбора типа расчета 



I. Задание свойств материала и типа элемента 

Переходим в Препроцессор. 

Задаем тип конечного элемента (рис. 8 и 9): 
Element Type→Add/Edit/Delete: 

 
Рис. 8. Диалоговое окно для добавления, редактирования и удаления типа 

элемента 

...Add→Elec Conduction→2D Quad 230→OK→Close: 

 
Рис. 9. Диалоговое окно выбора типа элемента 

Таким образом, нами был выбран плоский, состоящий из восьми узлов, основанный на 
токах электрический элемент. Элемент имеет одну степень свободы, напряжение на каждом 
узле. 2D Quad 230 хорошо подходит для моделей с криволинейными границами. Его 
используют для последующего низкочастотного анализа электри-ческого поля: 
установившейся электрической проводимости и др. 

Задаем свойства материала (рис. 10 и рис. 11). Характеристикой электролита необходимой 
для расчета в программе ANSYS, является значение удельного сопротивления. В 
справочниках для электролитов приводится величина удельной проводимости, в ANSYS 
можно задать лишь удельное сопротивление материала. Для 20% раствора NaCl удельная 
проводимость равна 0,1957 (Ом-1∙см-1, при 18°C). Если переводить в СИ, то удельное 

сопротивление будет равно 
0,051

1000,1957

1
=

⋅  Ом∙м. 



Итак, 0,051R0 =  Ом∙м. 
Material Props→Material Models: 

 
Рис. 10. Диалоговое окно выбора свойств материала 

Слева - порядковый номер материала (в нашем случае один материал), справа - его 
характеристики. 

 
Electromagnetics→Resistivity→Constant (удельное сопротивление электролита, одинаково 

по всем осям x-y). 

 
Рис. 11. Диалоговое окно для выбора удельного сопротивления электролита 

II. Создание геометрической модели 
Создаем геометрическую модель процесса электрохимического удаления заусенцев. 
Строим точки с указанными координатами на рабочей плоскости (табл.1). Значения 

вводятся в метрах. 
Modeling→Create→Keypoints→In Active CS: 

 



Рис. 12. Диалоговое окно для ввода координат точек 

Вводим номер точки и ее координаты (рис. 12). При этом нулевую координату 
допускается не указывать. Нажимаем APPLY , чтобы вывести точку на экран. Данная 
процедура повторяется для всех 9 точек. 

Чтобы отобразить номера точек и линий, заходим в меню управления 
PlotCtrls→Numbering и отмечаем там пункты Keypoint Number и Line Number (рис. 13). 

 
Рис. 13. Диалоговое окно отображения элементов 

Соединяем полученные точки линиями (рис.14) в следующей последовательности: точки 
2-3; 3-4; 4-5; 5-6; 6-7; 7-8; 8-9; 9-2. 

Создаем на основе полученного контура поверхность (рис. 15). 
Create→Areas→Arbitrary→By Lines 
Выбираем опцию замыкания линий LOOP и выбираем любую из контура. 

 
Рис. 15. Построение из контура поверхности 

III. Наложение на модель сетки конечных элементов 
В ANSYS существует несколько методов разбиения модели на конечные элементы. В 

данной лабораторной работе будем использовать ручной метод для построения свободной 
сетки. 

Предварительно необходимо задать размер ячейки (рис. 16). В нашем случае наиболее 
оптимальным размером будет 0,0001 м. 

Meshing→Size Cntrls→ManualSize→Global→Size: 



 
Рис. 16. Диалоговое окно для задания размера конечных элементов 

Затем производим деление поверхности на конечные элементы (рис. 17). 
Meshing→Mesh→Areas→Free: 

 
Рис. 17. Разбиение поверхности на конечные элементы 

IV. Расчет 
Переходим в «Решатель». 
Задаем известные нам начальные условия (рис. 18).  
 

 
Рис. 18. Приложение к катоду напряжений 



 
В нашем случае ими являются напряжение на аноде (линии 2-9 и 9-8), равное 20 В и 

напряжение на катоде (линия 5-6), равное 0 В. 
Solution→Define Loads→Apply→Electric→Boundary→Voltage→ On Lines 

Вначале приложим напряжение к катоду. Для этого отмечаем линию 5-6, нажимаем 
Apply, и в следующем окне (рис. 19) вводим напряжение равное, 0 В. Аналогично 
прикладываем напряжение, равное 20 В и к аноду по линиям 2-9 и 9-8. 

 
Рис. 19. Диалоговое окно для ввода значений напряжения 

Переходим к решению задачи: определению распределения потенциалов в электролите: 
Solve→Current LS→OK. 
Если в ходе решения не было ошибок, то появится окно "Solution is done!" (рис. 20), после 

чего можно приступить к просмотру результатов расчета. 

 
Рис. 20. Окно, показывающее успешное завершение расчета 

V. Анализ полученных результатов 
Переходим в Постпроцессор. 
Для просмотра распределения потенциалов в модели выполним следующее (рис. 21): 
General Postproc→Plot Result→Contour Plot→Nodal Solu: 



 
Рис. 21. Окно вывода результатов в графическом виде для распределения 

потенциалов 

В результате будет сгенерирована картина распределения потенциалов в области модели 
(рис.22). 

Для просмотра значений плотности тока для данной конфигурации произведем 
следующие операции (рис. 23): 

General Postproc→Plot Result→Vector Plot→Predefined: 

 
Рис. 23. Окно вывода результатов в графическом виде для плотности тока 

В результате будет сгенерирована картина плотностей тока для данной конфигурации 
(рис.24). 

Теперь смоделируем электрическое поле для схемы, которая показана на рис.5 (с учетом 
заусенца). Эта схема отличается от той, что рассмотрена выше наличием дополнительных 
точек 10 и 11. Строим точки с указанными координатами на рабочей плоскости (табл.2). 

Далее по аналогии соединяем полученные точки линиями в следующей 



последовательности: точки 2-3; 3-4; 4-5; 5-6; 6-7; 7-8; 8-9;9-10; 10-11; 11-2. Создаем на основе 
полученного контура поверхность, а затем разбиваем ее на конечные элементы (величина 
ячейки 0,0001 м). Прикладываем нагрузки в виде потенциалов к катоду и аноду. Вначале для 
катода по линии 5-6 напряжение 0 В, затем для анода по линиям 8-9; 9-10; 10-11 и 11-2 
напряжение +20 В. 

Произведем расчет и получим результаты, показанные на рис.25 и рис.26. 
 



САМОСТОЯТЕЛЬНАЯ  РАБОТА 

Данная лабораторная работа выполняется подгруппой, состоящей из трех студентов, 
каждый их которых сидит на своём рабочем месте. Вначале каждому студенту из подгруппы 
предоставляется схема для снятия заусенцев электрохимическим методом. Эти задания 
отличаются только схемой, все остальные величины одинаковы. 

Студенты производят расчет своих задач по методике, описанной выше. После чего у 
каждого из них получаются свои результаты. На основании их они должны выбрать наиболее 
лучшую схему обработки. Выбор должен производиться по двум критериям: по наибольшей 
плотности тока в зоне обработке и по простоте схемы (меньшее число изоляции и 
несложность конфигурации). 

Выбрав лучшую схему, студенты производят расчеты с этой схемой, но уже с учетом 
заусенца. У каждого из подгруппы будет своё задание. Они будут отличаться друг от друга 
изменением только одной величины, влияющей на картины распределения потенциалов и 
плотности тока. 

На основании полученных результатов студенты оформляют индивидуальный бланк 
отчета. 

Бланк должен содержать следующие пункты: 
1. Название и цель лабораторной работы. 
2. Расчетную схему с учетом заусенца для программы ANSYS, со всеми геометрическими 

размерами. 
3. Таблицу координат точек модели. 
4. Графики зависимостей изменяемых величин от плотности тока (у каждого варианта свой 

график). 
5. Выводы по работе. 
 



 

ВАРИАНТЫ  ЗАДАНИЙ 

Вариант  I 

 

 
Удельное сопротивление электролита (20% раствор NaCl при t=18°C): 
R0=0,051 Ом∙м. 

 



 

 
Граничные условия: 
Потенциалы на катоде: φкат ода=0 В; 
1 студент: 
Потенциал на аноде: φанода=+14 В. 
2 студент: 
Потенциал на аноде: φанода=+18 В. 
3 студент: 
Потенциал на аноде: φанода=+22 В. 
 

Вариант  II 

 

 



 

 
Удельное сопротивление электролита (20% раствор NaCl при t=18°C): 
R0=0,051 Ом∙м. 

 
Граничные условия: 
Потенциалы на катоде: φкат ода=0 В; 
Потенциал на аноде: φанода=+17 В. 
1 студент: 
МЭЗ=0,0002 м. 
2 студент: 
МЭЗ=0,0003 м. 
3 студент: 
МЭЗ=0,0004 м. 
 
Вариант  III 

 



 

 

 
 
Удельное сопротивление электролита (20% раствор NaCl при t=18°C): 
R0=0,051 Ом∙м. 

 



 

 
Граничные условия: 
Потенциалы на катоде: φкат ода=0 В; 
Потенциал на аноде: φанода=+18 В. 
1 студент: 
Удельное сопротивление электролита (5% раствор KCl при t=18°C): 
R0=0,1449 Ом∙м. 
2 студент: 
Удельное сопротивление электролита (20% раствор KCl при t=18°C): 
R0=0,0374 Ом∙м. 
3 студент: 
Удельное сопротивление электролита (40% раствор KCl при t=18°C): 
R0=0,0097 Ом∙м. 
 

Вариант  IV 

 

 



 

 
Удельное сопротивление электролита (20% раствор NaCl при t=18°C): 
R0=0,051 Ом∙м. 

 
Граничные условия: 
Потенциалы на катоде: φкат ода=0 В; 
Потенциал на аноде: φанода=+18 В. 
1 студент: 
Удельное сопротивление электролита (15% раствор CuSO4 при t=13,8°C): R0=1,89 Ом∙м. 
2 студент: 
Удельное сопротивление электролита (15% раствор CuSO4 при t=14,8°C): R0=1,80 Ом∙м. 
3 студент: 
Удельное сопротивление электролита (15% раствор CuSO4 при t=15,8°C): R0=1,70 Ом∙м. 

 

 



КОНТРОЛЬНЫЕ  ВОПРОСЫ 

1. Назовите три главных модуля программного комплекса ANSYS. 
2. Какими основными факторами обусловлено формообразование поверхности при ЭХО кромок? 
3. Какие требования предъявляются к технологическому процессу ЭХО кромок деталей? 
4. В чем отличие схем расположения катода-инструмента? 
5. Какие характерные элементы можно выделить при рассмотрении конфигурации кромки 

заготовки тонкостенной детали после штамповки? 
6. Как ведет себя плотность тока на поверхности с малым радиусом кривизны при ЭХО? 
7. Как в Ansys задать свойства материала? 
8. К чему приводит увеличение рабочей поверхности катода? 
9. В какой среде моделирования ANSYS производится расчет в данной работе? 
10. Какие особенности учитываются при проектировании катодного устройства? 
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ИССЛЕДОВАНИЕ ВЛИЯНИЯ ГИДРОДИНАМИКИ ПОТОКА ЭЛЕКТРОЛИТА НА ТОЧНОСТЬ ЭХО 
ЛОПАТОК ГТД 

Цель работы: установить характер распределения гидродинамических параметров потока 
электролита в объеме МЭЗ в процессе электрохимической обработки статорной лопатки компрессора и 
определить деформацию пера. 

Для проведения расчётов используется модель статорной лопатки компрессора третьей ступени 
двигателя НК14СТ. В процессе ЭХО лопатка базируется по замку и верхней полке. После закрепления 
осуществляется двусторонняя обработка пера лопатки с подвижными электродами. 
 



ОБЩИЕ  СВЕДЕНИЯ 

Развитие специальных отраслей машиностроения обусловило значительный рост потребления 
жаропрочных сплавов, высококачественных, нержавеющих и антикавитационных сталей, магнитных и 
твердых сплавов, обработка которых резанием связана с большими трудностями, а в некоторых случаях 
невозможна. Поэтому в промышленности для обработки деталей сложной конфигурации из новых 
конструкционных материалов все большее применение находит электрохимическая обработка (ЭХО). 

По сравнению с другими методами обработки металлов электрохимический способ обладает 
определенными преимуществами. Основываясь на явлении анодного растворения, он дает возможность 
обрабатывать любые металлы и сплавы независимо от их прочностных свойств. Инструмент-катод при 
этом не изнашивается, а обработка не влечет за собой изменения структуры поверхностного слоя 
материала. Для того чтобы сохранить структуру поверхностного слоя, необходимо применять операцию 
ЭХО на заключительной стадии обработки пера. Существенным недостатком, препятствующим 
применению операции на последнем этапе обработки, является недостаточная точность метода при 
обработке лопаток ГТД. 

Важнейшим параметром операции, определяющим точность копирования, является величина 
межэлектродного зазора. Уменьшение межэлектродного зазора повышает точность копирования. 
Однако вследствие ряда особенностей не удаётся снизить величину рабочих зазоров при двухсторонней 
ЭХО лопаток КНД меньше 0,4...0,6 мм, для средних лопаток – до 0,15 мм, для малых – до 0,1 мм. 
Основная причина этого - опасность короткого замыкания между пером лопатки и электродами из-за 
упругих деформаций пера в процессе ЭХО. 

Одним из факторов, влияющих на точность обработки, является гидродинамическое воздействие 
потока электролита на заготовку. При обтекании сложной формы профиля пера лопатки возникает 
перепад давления между поверхностями спинки и корытца, что в свою очередь приводит к деформации 
пера. Помимо того, для каждого значения межэлектродного зазора существуют оптимальные 
характеристики потока электролита, при которых выход по току является максимальным для 
исследуемого материала и для данных режимов обработки, а качество поверхности оптимальным. На 
рис. 1 представлен экспериментальный график, показывающий зависимость максимума выхода по току 
от скорости прокачки электролита [9]. 

 
Рис. 1. Экспериментальная зависимость выхода материала по току А от скорости прокачивания электролита 

при различных зазорах: 
1 – 0,75 мм; 2 – 0,5 мм; 3 – 0,25 мм 

В общем виде требования к потоку электролита в межэлектродном зазоре можно сформулировать 
следующим образом: 
1. Обеспечение стабильного протекания электродных реакций. 
2. Своевременное удаление продуктов этих реакций из рабочей зоны. 
3. Отвод тепла, возникающего в процессе электрохимической обработки. 

Для конкретных задач электрохимической обработки необходимо оценивать распределение 
скоростей электролита в межэлектродном зазоре, так как приведенные выше требования могут быть 
полностью удовлетворены только при обеспечении более или менее равномерного гидродинамического 
потока по всей обрабатываемой поверхности. 

Исходя из вышесказанного, можно обозначить две основные задачи, связанные с гидродинамикой 
протекания потока электролита в МЭЗ: 



1. Определение деформации пера лопатки от потока электролита. 
2. Оценка распределения гидродинамических параметров потока электролита в МЭЗ. 

В последнее время осуществить решение поставленных задач стало возможным посредством 
программных продуктов, разработанных на основе метода конечных элементов (МКЭ). Результаты, 
полученные с помощью этих программ, обладают высокой достоверностью. Использование подобных 
расчетов позволяет значительно снизить объем экспериментальных работ, что приводит к сокращению 
времени технологической подготовки производства и снижению себестоимости продукции. 

В данной работе производится анализ гидродинамики процесса ЭХО с помощью программы 
«Fluent», а также анализ деформации пера лопатки от гидродинамических сил в программной среде 
«ANSYS». 

Предложенная в данной лабораторной работе методика была успешно опробована на 
экспериментальных образцах и показала хорошие параметры сходимости по сравнению с опытными 
данными (рис. 2). 

  
Рис. 2. Сводная зависимость деформации заготовки от неравномерности 

распределения припуска по перу, полученная при экспериментах 
на образцах и компьютерном моделировании 

 



ЗАДАНИЕ 

Выполнить гидродинамический расчет течения электролита в канале МЭЗ, определив при 
этом максимальный перепад давления между поверхностями спинки и корытца. Произвести 
структурный расчет деформации пера от гидравлического воздействия потока электролита. 

Порядок выполнения лаборат орной работ ы 

Реализация поставленной задачи будет происходить в несколько этапов: 
1. Импорт трехмерной модели МЭЗ в проектный модуль «Fluent» - «Gambit». Создание 

объемной сетки конечных элементов в объеме модели. 
2. Импорт конечно-элементной модели МЭЗ в расчетный модуль «Fluent», задание 

граничных условий и расчет. Снятие значений давления с поверхности пера заготовки. 
3. Импорт трехмерной модели пера заготовки лопатки в «ANSYS». Создание объемной 

сетки конечных элементов в объеме модели, задание граничных условий и расчет. 
Определение деформации пера заготовки лопатки от гидравлических сил потока 
электролита. 

 



ПРАКТИЧЕСКАЯ ЧАСТЬ 

1 ЭТАП. Импорт  т рехмерной модели МЭЗ в проект ный модуль «Fluent» - «Gambit». 
Создание объемной сет ки конечных элемент ов в объеме модели. 

Программа «Fluent», является специализированным комплексом, предназначенным для 
решения гидрогазодинамических задач и состоит из двух модулей - проектного («Gambit») и 
расчетного («Fluent»). 

Геометрия модели для расчета в модуле «Fluent» создается в модуле «Gambit» 
непосредственно или импортируется в него посредством различных форматов (ACIS, 
Parasolid, IGES, Step). 

Для загрузки модуля запустить файл gambit.exe из директории: 
С:\FLUENT.INC\ntbin\ntx86. Далее импортируется трехмерная модель МЭЗ. 

F ile → Import → Parasolid → Browse… → MEZ.x_t → Accept → Accept. 

Выбор расчет ного модуля, для кот орого создает ся модель: 

Solver → Fluent5/6. 

Для построения упорядоченной сетки исходный объем разбивается на 4 части. Для этого 
осуществляется пост роение дополнит ельных поверхност ей. 

Operation → Geometry → Face  (первая кнопка в разделе, правая кнопка мыши - 
выбор из списка) → Ctrl + левая кнопка мыши (удерживая, выделяется участок возле 
входной кромки, см. рис.3) → Shift + левая кнопка мыши (последовательно выделяется 3 
отрезка) → Apply (см. рис.4). 

Аналогично в зоне выхода электролита. 

…  (вывод полноэкранного изображения модели), либо Ctrl + 2 x левая кнопка мыши 
→ Ctrl + левая кнопка мыши (удерживается, выделяется участок возле выходной кромки, см. 
рис.5 и рис.6) → Shift + левая кнопка мыши (последовательно выделяется 3 отрезка) → 
Apply (см. рис.7). 

Посредством булевой операции осуществляется разбиение исходного объема 
вспомогат ельными поверхност ями. 

Operation → Geometry → Volume → Shift + левая кнопка мыши (указывается 
объем) → Split with FACE (правая кнопка мыши - выбор из списка) → Shift+ левая кнопка 
мыши (указывается вспомогательная поверхность на выходе) → Снять метку Bidirectional → 
Apply… 

… Shift + левая кнопка мыши (указывается объем) → Split with FACE → Shift+ левая 
кнопка мыши (указывается вспомогательная поверхность на входе) → Apply… 



 

Рис. 8. Неполное разбиение объема на три части 

… Shift + левая кнопка мыши (указывается оставшийся объем) → Split with FACE → 
Shift+ левая кнопка мыши (указывается поверхность, по которой не произошло разбиения) 
→ Apply. 

 

Рис. 9. Окончательное разбиение объема на четыре части 

После того как исходный объем поделен, формируется упорядоченная сетка конечных 
элементов в каждом из полученных объемов. Вначале назначается число интервалов 
разбиения для отрезков.  

Operation → Geometry → Edge → Shift + левая кнопка мыши (выделяется 12 
отрезков по высоте модели МЭЗ) →  = 60 → Apply (рис.10, поворот модели - левая 
кнопка мыши)… 

…Ctrl + левая кнопка мыши (удерживая, выделяется участок около выходной кромки) → 
Shift + левая кнопка мыши (выделяется 4 отрезка на выходной кромке - 2 сверху и 2 снизу, 
см. рис.11) → (правая кнопка мыши - выбор из списка)  Ratio = 0.61 → 

 = 8 → Apply (рис.12) → Ctrl + левая кнопка мыши (удерживая, выделяется 
участок около входной кромки - 2 сверху и 2 снизу, рис.13) → (правая кнопка мыши - выбор 
из списка)  Ratio = 0.61 →  = 8 → Apply (рис.14). 

Применение функции распределения Bi-exponent, Successive Ratio и других (при 
показателе отличном от 1), позволяет сконцентрировать конечные элементы на необходимом 



участке и разрядить на второстепенном (сформировать т.н. пристеночную зону), что 
благоприятно сказывается на решении задачи и сокращает размер модели на диске. 

Разбиение сплайнов спинки и корыт ца: 

…Shift + левая кнопка мыши (выделяется 8 отрезков сплайна - 4 сверху и 4 снизу)→ 
 = 80 → Apply. 

На следующем шаге формирует ся сет ка конечных элемент ов в объеме над спинкой и над 
корыт цем (рис.15). 

Operation  → Geometry  → Volume  → Shift + левая кнопка мыши (выделяются 
объемы) → Elements: Hex →Type: Map → Apply. 

В той же последовательности осуществляется разбиение на конечные элементы объема 
выходной области. 

Operation → Geometry → Edge → Shift + левая кнопка мыши (выделяются 2 
отрезка, соединяющие выходные радиусы МЭЗ) →  = 18 → Apply (рис.16) → Shift 
+ левая кнопка мыши (выделяется 2 отрезка - выходные радиусы МЭЗ по одну сторону от 
спинки, рис.17) →  = 20 →  = 1.064 (сгущение по направлению к перу, 
если нет - Invert) → Shift + левая кнопка мыши (выделяется 2 отрезка - выходные радиусы 
МЭЗ со стороны корытца, рис.18) →  = 20 →  = 1.064 → Apply. 

Формирует ся сет ка конечных элемент ов на поверхност ях выходного радиуса МЭЗ. 

Operation → Geometry → Face  → Shift + левая кнопка мыши (выделяются 2 
поверхности) → Elements: Quad →Type: Map → Apply, рис.19. 

Для равномерного распределения элементов сетки в модуле «Gambit» предусмотрена 
специальная функция выравнивания - Smooth Face Mashes. 

… → Face  → Shift + левая кнопка мыши (выделяются поверхности) → Apply 
(рис.20). 

Упорядоченные сетки конечных элементов на самых проблемных поверхностях 
сформированы, осуществляется разбиение объема выходной област и МЭЗ. 

Operation  → Geometry  → Volume  → Shift + левая кнопка мыши (выделяется 
объем) → Elements: Hex →Type: Map → Apply (рис.21). 

Аналогично осуществляется разбиение на конечные элемент ы объема входной област и. 

Operation → Geometry → Edge → Shift + левая кнопка мыши (выделяется 2 
отрезка, соединяющих входные радиусы МЭЗ) →  = 22 → Apply (рис.22) →Shift + 
левая кнопка мыши (выделяем 2 отрезка - входные радиусы МЭЗ по одну сторону от спинки, 
рис.23) →  = 18 →  = 1.064 (сгущение в сторону пера, если нет - 
Invert) → Shift + левая кнопка мыши (выделяем 2 отрезка - входные радиусы МЭЗ со 
стороны корытца, рис.24) →  = 18 →  = 1.064 → Shift + левая кнопка 
мыши (выделяется 2 отрезка - входные радиуса лопатки, рис.25) →  = 22 → Apply. 

Формирует ся сет ка конечных элемент ов на поверхност ях входного радиуса и 
поверхност и входа в МЭЗ. 

Operation → Geometry → Face  → Shift + левая кнопка мыши (выделяются 2 



поверхности) → Elements: Quad/Tri →Type: Map → Apply (рис.26). 

… → Face  → Shift + левая кнопка мыши (выделяются поверхности) → Apply 
(рис.27). 

После того как сформированы упорядоченные сетки конечных элементов поверхностей, 
осуществим разбиение объема входной област и МЭЗ. 

Operation  → Geometry  → Volume  → Shift + левая кнопка мыши (выделяется 
объем) → Elements: Hex →Type: Map → Apply (рис.28). 

На данном этапе объемная конечно-элементная модель МЭЗ (рис.29) сформирована, 
остается назначить дополнительные атрибуты для передачи модели в расчетный модуль 
«Fluent». 

Маркировка поверхност ей сплайнов. 

Operation  → Zones  → Type: Wall → Shift + левая кнопка мыши (выделяется 
поверхность корытца) → Name: kop → Apply → Shift + левая кнопка мыши (выделяется 
поверхность спинки) → Name: spin → Apply … 

Маркировка инициализирующих поверхност ей: 

Operation  → Zones  → Type: Pressure_inlet → Shift + левая кнопка мыши 
(выделяется поверхность входа) → Name: vxod → Apply → Type: Pressure_outlet → Shift + 
левая кнопка мыши (выделяется поверхность выхода) → Name: vIbxod → Apply. 

Назначение объема прот екания элект ролит а. 

Operation  → Zones  → Type: F luid → Shift + левая кнопка мыши (рамкой 
выделяются все 4 объема) → Name: electrolit → Apply. 

Экспорт  конечно-элемент ной модели в расчет ный модуль «Fluent». 

F ile → Export → Mesh… → Accept. 

2 ЭТАП. Импорт  конечно-элемент ной модели МЭЗ в расчет ный модуль «Fluent», задание 
граничных условий и расчет . Снят ие значений давления с поверхност ей пера лопат ки. 

Рабочая среда модуля «Fluent» представляет собой текстовое окно, в котором 
прописываются выполняемые действия, и командную панель (рис.30). При выборе какой-
либо команды появляется дополнительное окно. 

После запуска программы в диалоговом окне выбирается модуль для трехмерных задач: 

3d→Run. 

Импорт  конечно-элемент ной модели: 
F ile → Read → Case → MEZ.msh → OK, рис.31. 

В текстовом окне появится информация об импортированном объекте. Во избежание 
ошибки при расчете необходимо запустить процедуру проверки геометрии. 

Grid → Check. 

После вывода информации на экран проверяется значение минимального объема (оно не 
должно быть меньше нуля): 

Volume statistics: 
   minimum volume (m3): 5.351026e-13. 



Просмот р импорт ированной модели: 
Display → Grid… → Surface (выбрать все) → Display → Close. 

При нахождении в графическом окне просмотра левая кнопка мыши - поворот модели; 
рамка выделения (скроллом): слева направо - приблизить, справа налево - отдалить. 

Модели, создаваемые в «Gambit», не имеют размерности, поэтому прежде всего, 
необходимо отмасштабировать модель в нужных единицах измерения. 

Grid → Scale→ Grid was created in → mm → Scale… → Close. 

Задание граничных условий и параметров модели, необходимых для расчета. 
Одним из основных параметров модели, определяющих результат решения, является 

модель т урбулент ност и. При проведении исследования на образцах было обосновано 
применение модели турбулентности k-ε. 

Define → Models → Viscous… → k-ε → OK→ Close. 

Задание мат ериала элект ролит а. Плотность - 1010 кг/м3, вязкость - 0.00101 кг/м∙с. 

Define → Materials… →Fluent Database… → water-liquid → Copy → Close → Density = 1010 
→ Viscosity = 0.00101 → Change/Create → Close. 

Задание граничных условий. На этапе проектирования модели в модуле «Gambit» уже 
были заданы основные зоны МЭЗ: electrolit - объем, заполняющий МЭЗ, vxod - поверхность 
входа электролита, vibxod - поверхность выхода электролита. Для указанных зон задаются 
следующие параметры: electrolit - указывается материал, созданный на предыдущем этапе 
(water-liquid); vxod - инициирующее и полное давление - 499999 и 500000 Па соответственно; 
vibxod - давление на выходе - 100000 Па. Отличие инициирующего давления от полного 
позволяет точнее определить распределение параметров электролита на входе в МЭЗ, что 
сокращает в свою очередь время решения задачи. 

Define → Boundary Conditions… → electrolit→ fluid →Set → Material Name→ water-liquid → 
OK→ vxod → pressure-inlet → Set → Gauge Total pressure = 500000 (Па) → Supersonic/Initial 
Gauge pressure = 499999 (Па) → OK→ vibxod → pressure-outlet → Set → Gauge pressure = 
100000 (Па) → OK → Close. 

Конт роль за ходом решения осуществляется с помощью графика сходимости итераций. 

Solve → Monitors → Residual… → Options от мет ит ь Plot → OK. 

Для запуска решения инициирует ся т ечение из зоны vxod. 

Solve → Initialize → Initialize … → Compute From → vxod → Init → →Close. 

Solve → Iterate… → 300 → Apply → Iterate → Close. 

После запуска решения параметры итераций будут отображаться в графическом виде 
(рис.32). Появление в текстовом окне консоли надписи Solution is converged! 
свидетельствует о завершении расчета. 

После того как решение найдено, можно получать любую интересующую информацию о 
параметрах течения электролита в любой точке модели МЭЗ, рис.33. 

Display → Contours… → Option → Filled → Contours of… →Pressure → Total Pressure → 



Surface (выбрат ь все) → Display → Close. 

Съем данных о давлении производится в среднем сечении МЭЗ (при допущении о 
равномерном распределении давления по высоте лопатки). 

Сечение МЭЗ секущей плоскост ью Z = 0.07. 
Surface → Iso-Surface → Surface of constant → Grid… → Z Coordinate → Compute 

(показывает диапазон изменения выбранного параметра) → Iso Values = 0.07 (m) → New 
Surface Name → Z = 0.07 → Close. 

От ображ ение созданного сечения (рис.34). 

Display → Grid… → Surface → Z = 0.07 → Display → Close. 

С помощью инструмента линия/отрезок создаются отрезки в трех зонах полученного 
сечения (возле входной кромки, около центра тяжести сечения лопатки, около выходной 
кромки). 

Surface → Line/Rake → Select Point with mouse (на заднем плане должно находиться 
графическое окно с сечением) → 2 наж ат ия правой клавишей мыши по ст енкам МЭЗ 
(рис.35) → New Surface Name = a → Create →… 

… → Select Point with mouse →2 наж ат ия правой клавишей мыши по ст енкам МЭЗ → 
New Surface Name = b → Create → … (рис.36). 

… → Select Point with mouse →2 наж ат ия правой клавишей мыши по ст енкам МЭЗ → 
New Surface Name = с → Create → Close. 

Отобразим графически искомое давление, распределенное по ранее созданным отрезкам, 
рис.37. 

Plot → XY Plot… → X = 0, Y = 1, Z = 0 → Y Axis Function → Pressure → Total Pressure → X 
Axis Function → Direction Vector → Surface → a, b, c → Plot → Close. 

По два отрезка каждого цвета характеризуют соответствующее распределение давления 
электролита в канале над спинкой и над корытцем. Из рис.38 видно, что основной перепад 
давления приходится на область центра тяжести профиля пера, поэтому именно этот перепад 
давления задается в «ANSYS» для определения деформации лопатки от гидравлических сил. 

3 ЭТАП. Импорт  т рехмерной модели пера загот овки лопат ки в ANSYS. Создание 
объемной сет ки конечных элемент ов в объеме модели, задание граничных условий и расчет . 
Определение деформации пера загот овки лопат ки от  гидравлических сил пот ока 
элект ролит а. 

Для внесения ясности в дальнейшее описание обозначим панель с командами, 
расположенную в верхней части окна - UM (Utility Menu), а панель, расположенную слева - 
MM (Main Menu). 

Работа по определению деформации будет осуществляться по шагам. 
1. Выбор типа задачи: 

ММ → Preferences → Structural → OK. 

2. Выбор типа конечных элементов. 
Для создания упорядоченной сетки конечных элементов необходимо воспользоваться 

двумя типами: 



ММ → Preprocessor → Element Type → Add/Edit/Delete → Add… → В левом окне 
выбирается Solid, в правом - Brick 8node 45 (для создания объемной сетки конечных 
элементов) → Apply → В левом окне выбирается Shell, в правом - Elastic 4node 63 (для 
создания плоской сетки конечных элементов) → OK → Close. 

3. Ввод констант для конечного элемента SHELL63: 
ММ → Preprocessor →Real Constants → Add/Edit/Delete → Add… → (выбирается 

SHELL63) OK → (сверху, во второй строке) 0.0001 (разделитель - точка) → OK → Close. 
4. Задается материал лопатки: 
ММ → Preprocessor → Material Props → Material Models → (в правом окне) Structural → 

Linear → Elastic → Isotropic → EX=2e+11 (модуль Юнга, МПа), PRXY=0.3 (коэффициент 
Пуассона) → Density → Dens=7800 (плотность, кг/м3) → OK → Close. 

5. Импорт трехмерной модели лопатки из соответствующей директории: 
UМ → Fail → Import → PARA…→ LOP.x_t → OK. 
6. Подготовка модели к созданию сетки конечных элементов, назначение элемента SHELL 

63 для поверхностей: 
ММ → Preprocessor → Meshing → Mesh Attributes → All Areas → Type: SHELL 63 → OK. 
ММ → Preprocessor → Meshing → Mesh Tool → … следующие шаги будут выполняться с 

помощью появившегося окна Mesh Tool. 
7. Деление линий: 
…lines → Set → (выбираются все 6 линий) OK → Size=0.001 → OK. 
8. Создание плоской упорядоченной сетки на поверхностях спинки и корытца лопатки 

(для появления на экране окна Mesh Tool может понадобиться кнопка  Raise Hidden, 
расположенная справа от командной строки): 

…Mesh (из раскрывающегося списка) Areas → (отметить) Quad, Mapped → (из 
раскрывающегося списка) 3 or 4 sided → Mesh → (указывается поверхность спинки и 
корытца) OK.  

Для удобства выделения левая кнопка мыши не отпускается до выбора нужного объекта. 
9. Создание объемной упорядоченной сетки: 
… Mesh (из раскрывающегося списка) Volumes → (отметить) Hex, Sweep → (из 

раскрывающегося списка) Auto Src/Trg → Sweep → Pick All → Mesh Tool → Close. 
10. Задание граничных условий (по крайним сечениям лопатки - жесткая заделка): 
ММ → Preprocessor → Loads → Define Loads → Apply → Structural → Displacement → 

On Areas → (выбираются два крайних сечения лопатки) → All DOF → OK. 
11. Приложение гидродинамического давления к поверхности корытца: 
UМ → Select → Entities…→… следующие шаги будут выполняться с помощью 

появившегося окна Select Entities. 
… (первая строчка) Areas → (вторая строчка) By Num/Pick → Apply → (выбирается 

поверхность корытца) OK → Raise Hidden → (первая строчка) Elements → (вторая строчка) 
Attached to → (отметить) Areas → Apply → Plot → (с правой стороны рабочего окна) Right 
View (вид справа) → ММ → Preprocessor → Loads → Define Loads → Apply → Structural → 
Pressure → On Elements → (отметить) Box → (выделяется прямоугольная область в районе 
центра тяжести сечения лопатки, отступая примерно по 9 элементов от краев поверхности, 
рис.39) OK → Value=313000 (Па) → OK 

12. Приложение гидродинамического давления к поверхности спинки: 



…Raise Hidden → Sele All → Plot → Isometric View → Raise Hidden → (первая строчка) 
Areas → (вторая строчка) By Num/Pick → Apply → (выбирается поверхность спинки) OK → 
Raise Hidden → (первая строчка) Elements → (вторая строчка) Attached to → (отметить) 
Areas → Apply → Plot → (с правой стороны рабочего окна) Left View (вид слева) → ММ → 
Preprocessor → Loads → Define Loads → Apply → Structural → Pressure → On Elements → 
(отметить) Box → (выделяется прямоугольная область в районе центра тяжести сечения 
лопатки, отступая примерно по 9 элементов от краев поверхности, рис.40) OK → 
Value=213000 (Па) → OK → Raise Hidden → Sele All → Plot → Isometric View (рис.41). 

13. Запуск расчета: 
ММ → Solution → Solve → Current LS → OK → Yes (при появлении предупреждения). 
14. Вывод на дисплей информации о распределении деформации по перу лопатки: 
ММ → General Postproc → Plot results → Contour Plot → Nodal Solu → DOF Solution → 

Displacement vector sum → OK. 

 

Рис. 42. Распределение деформации по перу лопатки  
 

Из рисунка видно, что максимальная деформация от гидравлических сил, локализованная 
на выходной кромке пера, составила 0,0383 мм. 
 



САМОСТОЯТЕЛЬНАЯ РАБОТА 

При проведении самостоятельной работы используются файлы из рабочей директории, содержащие 
решение гидродинамических задач для различных ситуаций, возникающих на производстве:  

1. 0.25(1.0).cas – равномерный канал МЭЗ 0,25 мм, перепад давления – 4 атм.; 
2. 0.25(1.0)_3at.cas – равномерный канал МЭЗ 0,25 мм, перепад давления – 3 атм.; 
3. 0.15(1.0).cas – равномерный канал МЭЗ 0,15 мм, перепад давления – 4 атм.; 
4. 0.15(1.0)2cx_2.cas – равномерный канал МЭЗ 0,15 мм, перепад давления – 4 атм., подача 

электролита на выходную кромку пера; 
5. 0.15_3cx_all3.cas – равномерный канал МЭЗ 0,15 мм, перепад давления – 4 атм., подача 

электролита вдоль пера лопатки; 
6. 0.15(1.0)8at.cas – равномерный канал МЭЗ 0,15 мм, перепад давления – 8 атм.; 
7. 0.15(7.6.400).cas – диффузорный канал МЭЗ над спинкой, перепад давления – 3 атм.; 
8. 0.15(7.6)2.cas – конфузорный канал МЭЗ над спинкой, перепад давления – 4 атм.; 
9. 0.15(7.6)3.cas – диффузорный канал МЭЗ над корытцем, перепад давления – 4 атм.; 
10. 0.15(7.6)4.400.cas – конфузорный канал МЭЗ над корытцем, перепад давления – 3 атм.; 
11. 0.15+380.cas – поворот пера лопатки относительно электродов по часовой стрелке; 
12. 0.15--380.cas – поворот пера лопатки относительно электродов против часовой стрелки; 
13. 0.15(1.0)sec_phase_1600_end.cas – равномерный канал МЭЗ 0,15 мм, перепад давления – 4 атм., 

вторая фаза – пары электролита; 
14. 0.15(1.0)sec_phase_end_900.cas. – равномерный канал МЭЗ 0,15 мм, перепад давления – 8 атм., 

вторая фаза – пары электролита; 
15. 0.15(7.6.400)_azot.cas – диффузорный канал МЭЗ над спинкой, перепад давления – 3 атм., вторая 

фаза – 10%-я примесь азота на входе в канал МЭЗ. 
Получив задание от преподавателя и произведя съем значений давления в трех зонах на поверхности 

пера, студент задает максимальный перепад давления по перу лопатки при структурном расчете. 
Структурный расчёт будет производиться автоматически путём запуска макроса из основного меню 
программы. Для проведения расчётов необходимо внести изменения в текст макроса MEZ.txt 
находящегося в рабочей директории программы. В строке SFE,_Y1,1,PRES, ,313000, , , и схожей по 
содержанию SFE,_Y1,1,PRES, ,213000, , , следует соответствующим образом заменить заданные 
значения давления (213000 и 313000 Па) на новые. 

Запуск макроса осуществляется с помощью команды:  
Utility Menu → File → Read Input from → MEZ.txt →OK. 

 



СОДЕРЖАНИЕ ОТЧЕТА 

1. Результаты решения гидродинамической задачи течения электролита в объеме МЭЗ (график 
распределения давления по соответствующим участкам пера лопатки). 

2. Решение структурной задачи (максимальная деформация пера). 
3. Повторное решение задачи для модели МЭЗ, назначенной преподавателем. 
4. Выводы о проделанной работе. 

 



КОНТРОЛЬНЫЕ ВОПРОСЫ 

1. Какие основные требования предъявляются к потоку электролита в МЭЗ? 
2. Назовите минимальные значения межэлектродных зазоров, устанавливаемых при обработке 

лопаток различной длины. 
3. Какие программные продукты использовались в данной работе? На каком общем принципе 

основан механизм решения в этих программах? 
4. Из каких модулей состоит программный комплекс «Fluent»? 
5. Какие параметры операции ЭХО учитывались в данной работе? 
6. Какие свойства электролита учитывались при гидродинамическом анализе течения электролита в 

МЭЗ? 
7. Каким образом на деформацию пера лопатки влияет величина МЭЗ? 
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